前      言
 

    图文地质资料的扫描数字化及其质量标准，既是实现图文地质资料现代化管理的一项重要基础工作，也是建成“图文地质资料数据库”的前提条件。为配合数字国土工程“图文地质资料数据库”项目的建设，使其生产过程规范化，并确保图文地质资料数字化工作的质量，特制订本标准。
本标准是在1997年原中国地质矿产信息研究院制订的《光盘存储地质资料规范汇编》的基础上，经过二年的生产实践，总结了其中大量经验后，进行了补充和修订，并结合图文地质资料的特点及扫描数字化工作的实际需要而制订。
本标准的附录B是标准的附录，附录A、C、D、E、F是提示的附录。
本标准由国土资源部提出。
本标准由国土资源部信息中心归口。
本标准起草单位：国土资源部信息中心。
本标准主要起草人：尚武、黄冰、王春宁、于瑞洋、陈培章、李淑仁。
1  范围
本标准规定了图文地质资料扫描数字化过程中的文件组织、数据制作、目录编制及数据保存的一般方法和质量要求。
本标准适用于对纸介质图文地质资料所进行的扫描数字化工作。
本标准不包括使用其它技术手段进行图文地质资料数字化的方法和质量要求。
2  引用标准
    下列标准所包含的条文，通过在标准中引用而构成为本标准的条文。在标准出版时，所示版本均为有效。所有标准都会被修订，使用本标准的各方应探讨使用下列标准最新版本的可能性。
DA/T 1－1992             档案工作基本术语
DZ/T 0131－94            固体矿产勘查报告格式规定
3  定义
本标准采用下列定义：
3.1  电子文件
    能被计算机系统识别、处理，按一定格式存储在磁带、磁盘或光盘等介质上，并可在网上传送的数字代码序列。
3.2  图文地质资料扫描数字化
    通过扫描的方法把以纸介质为载体的图文地质资料由模拟信息转变为数字信息，并按一定的质量要求对电子文件进行加工和制作，然后存储在磁带、磁盘或光盘等介质上的过程。
3.3  原件
用于扫描的纸质图文地质资料。
3.4  一份原件
指在同一档号内的所有图文地质资料。
3.5  图表型文件
原件中某些由图和表共同组成的一类文件。
3.6  栅格文件
原件经扫描后而所形成以点阵形式保存的电子文件。
3.7  栅格文件册
对应于图文地质资料某个分册栅格文件的集合。
3.8  电子文档
同一份原件经扫描数字化后形成的电子文件的总和。
4  原件处理
原件处理是指在扫描之前，对原件进行的修整、分类、组织编排等项工作。
4.1  原则
4.1.1  基本保持原件原有的形式，在此基础上，为便于利用，对一些特殊情况做相应处理。
4.1.2  对原件的处理要做到完整、齐全。
4.2  修整
    为了保证扫描数字化工作的速度和质量，对图纸的折痕、原件中的破损处及不清晰处所进行的熨平、修复或清绘等工作。
4.3  分类
依据图文地质资料的内容和形式，将原件分为七类，即封面类、正文类、审批类、附图类、附件类、附表类及其它类。但在实际分类中，由于原件内容上的差异，每一份原件不一定都包含上述所有七类。
4.3.1  封面类
    封面类仅指正文的封面以及未与正文连续排页的题名页、摘要、序言、前言、绪论、工区全景照片等文件材料。
4.3.2  正文类
  包括图文地质资料正文的主体部分以及与主体部分装订在同一册内的图版、照片及后记、参考资料、插图、插表、制印签等文件材料。 
4.3.3  审批类
    包括对图文地质资料进行评审、验收所形成的审批意见书、决议(认定)书等文件材料。
4.3.4  附图类
  除正文中插图以外的各种图形文件。
  原件中未明确规定属那类的图表型文件原则上归入附图类。
4.3.5  附件类
除正文外的其它附属文字材料以及原件中已明确归入附件的表、图形、图表型文件材料。
4.3.6  附表类
    除正文中插表以外的各种表格式文件材料。
4.3.7  其它类
    指不能归入上述六类中的原件的勘误表、原件的目录、责任表等文件材料。
4.4  组织编排
   原件的组织编排是在一份原件内进行的。
4.4.1 加页规则
a．加页是指成册文件中两页之间夹有的无页码的文件（如插表或插图），以及图件中只占一个顺序号的图册和多张附图。
b．加页规则是将无页码页作为其前一页的加页，连续加页数最大为35；当超过35，或者是加页数超过该类文件总数的30%时，应重新编排文件顺序号。
c. 目录检索条目所涉及的页及位于某类文件尾部无页码的页不能做为加页。
4.4.2  空白页
a. 空白页在下列两种情况中出现：
—— 原件中成册文件内有页码但无内容的页；
—— 因拼接而形成的空白页。
b. 空白页要按原有顺序编排在相应的类别中，可以不标识页码。
c. 在拼接过程中，当产生的空白页超过该册文件总数的30%时，不再做空白页，而应重新编排文件顺序号。
4.4.3  封面类的组织编排
    一份原件只能有一个封面文件册。当一份原件中有多个正文时，应将多个正文的封面组织在一个封面文件册内。
4.4.4  正文类的组织编排
  对于正文类，册的组织应以页码是否连续为前题，页码连续的，无论原件是几册，都作为一册进行组织；页码不连续的，按其实际情况分别组织成册，编排册序号。
4.4.5  审批类的组织编排
a. 审批文件无论是独立装订还是与其它各类文件装订在一起，均应单独组织成一册。不过，当审批文件在其它文件(如正文)前且页码又是连续时，为了避免将审批文件提出后其它文件前出现大量空白页，此时除单独组织成审批类外，其它文件中的审批可予以保留。
b. 多个审批文件合订成一册时，按原有的装订顺序进行编排。否则，要将审批文件按照审批级次由高到低依次进行编排；对同级的决议书、审批意见书，以“决议”在前，“审批意见”在后的顺序进行组织编排；同级、同类的审批文件，按时间顺序由新到老进行编排。
4.4.6  附图类的组织编排
a. 附图按原图顺序号依次进行编排。
b. 对夹在图件中间只占一个顺序号的图册和多张附图，按本标准4.4.1部分的加页规则进行编排。
c. 对分开制印的附图，以是否影响浏览为拼接的原则，不影响浏览的，原则上一律不拼接；若进行拼接，则对拼接后剩余附图的处理，原则上应尽量重编顺序号，其次才作空白页。此外，当一张图由于太大而被分扫成二个文件时，对多出一个文件的处理也应遵循上述原则。
4.4.7  附件类的组织编排
    附件类组织编排的方法与附表相同。
4.4.8  附表类的组织编排
a. 成册附表的编排以页码是否连续为前题，页码连续的，无论原件是几册，都作为一册进行组织；页码不连续的，按照其原有册序分别组织成册，编排册序号。
b. 原件只有单张表的应组成一册；原件中既有单张表又有成册表时，应视单张表与成册表的关系或将其组织在成册表中或单独成册。
c. 与正文或附件装订在一起且页码连续编排的附表，可将其组织在相应的正文或附件类中，不再单独分类；但如果页码不是连续编排时，要将其作为附表类单独进行组织，编排册序号。
d. 当同一表册中存在较多的同一张表被左右分割制印的情况时，要将被分开的每页表合成一页，重新编排其顺序号。
e. 附表类封面页的首页不得作加页，其主体部分的第一页也不得作加页，为了减少更改顺序号的工作量，可将非目录检索页编成加页。
4.4.9  其它类的组织编排
    其它类的组织编排方法可参照上述各类中相应文件的组织编排。
4.4.10  工作记录
    在原件处理过程中所进行的分类、拼接、加页、重编页码等项工作，可形成工作记录，以便后续工作参考。
5  扫描
5.1  原则
    按照原件处理的结果对原件进行完整、齐全的扫描，保证栅格文件的扫描质量，并使栅格文件具有最少的整饰工作量。
5.2  工作内容
5.2.1  选择合适的扫描方式。对于用黑白扫描无法正确反映其上主要地质信息的彩色图件，以及彩色照片、彩色封面，应使用彩色扫描；对于黑白照片及使用黑白扫描不能获得清晰图像的原件，应使用灰度扫描；对于上述情况外的其它原件应使用黑白扫描；此外，对一些色彩简单、充填颜色在三种以内(不含黑白色)、色差较大的彩色图件，也可以先进行黑白扫描，然后再通过其它方法转换成彩色文件，具体方法见附录A(提示的附录)。
5.2.2  选择适当的分辩率。一般情况下对彩色、灰度或黑白的原件，其分辩率的选择原则应以栅格文件的清晰度为准，实际工作时可参考图纸300dpi，文字、照片200dpi。当栅格文件的清晰度不佳时，应根据实际情况调整分辩率及其他相关参数。

5.2.3  选择合适的消兰方法。对于黑白图件，应根据其印刷质量、清晰度等情况进行选择。

5.2.4  根据原件的实际情况选择合理的门限参数、对比度及亮度等扫描参数。

5.2.5  对原件本身就是空白页及因拼接而形成的空白页的，进行空白页扫描，空白页的格式见附录B（标准的附录）。

5.3  质量要求

5.3.1  一份原件所形成的栅格文件要齐全，既不能漏扫也不能多扫或重扫。

5.3.2  栅格文件的清晰度应最大限度地接近（等同于）扫描原件，扫描内容要完整，画面要端正。凡原件中可识别的内容（污迹除外），在栅格文件的打印结果和屏幕显示结果中应亦可识别。

5.3.3  对原件有精度要求的栅格文件（如地质图、剖面图、储量计算图等）与原件的对角线误差和边长误差均不得超过±0.1%。

5.3.4  保证扫描后彩色栅格文件的色彩要有较好的还原度，灰度栅格文件要有层次感。

6  栅格文件
6.1 命名规则

栅格文件的命名应依据原件分类、组织及编排的结果。

栅格文件名由十二个半角字符组成，分为类别位、册序位、加页位、顺序位、间隔符及文件名后缀共六部分，如图1所示。

　图1 栅格文件名的结构示意图

　

　

　

6.1.1 类别位
用一位英文字母标识该栅格文件的类别，类别位的取值见表1。

表1  栅格文件名类别代码表
	类别名称
	栅格文件名类别位取值
（字母大小写均可）

	封面类
	F

	正文类
	Z

	审批类
	S

	附图类
	T

	附件类
	J

	附表类
	B

	其它类
	Q


6.1.2  册序位

a. 长度及数据类型：两位，第一位是数字或字母，第二位是数字。

b. 标识内容：标识栅格文件册的序号，分册规则参见本标准4.4中的相应内容。

c. 取值方法：当册序小于等于99时，册序位的值在“01”至“99”之间，直接按册序取值。当册序超过99时，第100册的栅格文件名中册序位取值为“A0”；100册以后册序位取值方法如下：以A0为起始值，册序位第二位仍是10进制数字，步长为1依次递增，第一位为英文字母，当第二位产生进位时第一位字母按26个英文字母顺序递增，如: A9（109册），B0（110册），K0（第200册）。

册序位的取值见表2：

表2  栅格文件名册序取值表
	册序
	栅格文件名册序位的取值
（字母大小写均可）

	1至99
	01至99

	100至109
	A0、A1、A2…A9

	110至119
	B0、B1、B2…B9

	120至129
	C0、C1、C2…C9

	…
	…

	200至209
	K0、K1、K2…K9

	210至219
	L0、L1、L2…L9

	…
	…

	340至349
	Y0、Y1、Y2…Y9

	350至359
	Z0、Z1、Z2…Z9


6.1.3  加页位
a. 长度及数据类型：一位，下划线符“_”或数字或英文字母。
b. 标识内容：标识该栅格文件是否为加页，如果是加页则标识该栅格文件是第几张加页，关于“加页”的说明参见本标准4.4.1。
c. 取值方法：栅格文件不是加页时，加页位的值为：“_”（下划线符）；栅格文件是第n张加页，当n小于10时，加页位的值为n，当n大于等于10且小于等于35时，加页位的值按26个英文字母顺序递增。第10张加页的栅格文件名的加页位用字母“A”表示，第11张加页用“B”表示…，以此类推。加页位的取值参见表3。
 
表3  栅格文件名加页取值表
	加页情况
	栅格文件名加页位的取值
（字母大小写均可）

	不是加页
	_（下划线符）

	是第n张加页（n<10）
	1至9

	是第n张加页（10≤n≤35）
	A、B、C…X、Y、Z


 
6.1.4  顺序位
a. 长度及数据类型：四位阿拉伯数字。
b. 标识内容：标识该栅格文件在本册中的顺序。
c. 取值方法：根据本标准4.4中对附图顺序号及其他各类文件页码的编排处理，确定该栅格文件顺序位的取值，取值范围从“0001”开始，截止到“9999”。
6.1.5  间隔符
由一位小数点“.”构成。
6.1.6  文件名后缀
栅格文件名后缀由三位英文字母组成，标识该栅格文件的格式（参见本标准6.2）。文件名后缀应与栅格文件的格式一致，其取值为“TIF”（黑白）或“JPG”（灰度或彩色）。
6.2  栅格文件的格式
6.2.1  黑白：使用CCITT Tiff Group 4 fax 压缩格式（.TIF）。
6.2.2  灰度或彩色：使用8位或24位JPEG压缩格式（.JPG）。
6.3  示例

7  整饰
整饰是指为了使扫描后形成的栅格文件清晰、美观而进行的反转、调整页边距、去污、旋转、纠斜、修补等工作。
7.1  原则
整饰后的栅格文件应保持图文地质资料的原有信息，不能违背图文地质资料的原意。
7.2  主要工作内容
7.2.1  反转：对呈负片的栅格文件进行黑白反转。
7.2.2  调整页边距：裁除栅格文件上过宽的页边距，增补栅格文件上过窄的页边距。
7.2.3  去污：删除栅格文件图像上的污点和污迹。
7.2.4  纠斜：对明显倾斜的栅格文件进行纠斜。
7.2.5  旋转：对栅格文件上非正视的图像和文中的插图、插表、照片等有必要时进行适当的旋转、拼接。

7.2.6  修补：栅格文件图像上的信息出现缺失时给予必要的修补。

7.2.7  拼接：对于分页印制(如纵向分割等)的图、表采用拷贝图、表（栏）头或拼接的方式来保证图、表的完整性。

7.2.8  勘误：对照原件的勘误表更正栅格文件上的错误信息。

7.3  质量要求

7.3.1  保证整饰后栅格文件上图文地质信息的齐全和完整。

a. 栅格文件的图像应真实地记录图文地质的信息；文字部分以能读懂一段文字(一句话)为准； 各种字符，特别是重要的数字和符号应正确无误； 图形部份，在1：1显示下的主要信息应清楚，重要的线段应连续可读。

b. 分页印制的图、表按要求不进行拼接时，应保证其上图名、图例或表（栏）头的完整性，不全的部分应补齐；

7.3.2  栅格文件的图像应能满足阅读的要求。

a. 栅格文件的图文地质信息应是垂直向上的正片图象, 其显示方向应从上到下；

b. 栅格文件的图像应端正，倾斜度不得大于0.3°；

c. 栅格文件上很小的污迹也不应影响阅读。

7.3.3  尽可能使栅格文件的图像清洁、美观。

a. 栅格文件图像的上下、左右要各自留出大约2cm的页边距；

b. 整饰过的文字、数字、符号、线段在字号、字体、线型、颜色等属性上应尽可能与原件保持一致；

7.3.4  拼接后的图、文、表应符合图文地质资料的原意；

a. 拼接后的栅格文件不能缺失有用信息和产生多余信息，原有的页码、责任表等原则上应做保留；

b. 有精度要求的图件，拼接后其拼接线与原件相比，中心误差不得超过0.5mm；当因原件误差造成无法满足质量要求时，应尽量保证中心点（线）的精度要求；

c. 采用拷贝图名、表名或表头的方式进行拼接时应保证各种线条的连续性。

7.3.5  对于少部分原件本身就不清楚且又无法考证的信息，原则上不做整饰。

8  目录制作

    电子文档的目录由类目录、文件目录及盘目录构成。

8.1  原则

8.1.1  目录的建立应遵循盘目录全、类目录简、文件目录不产生歧义的原则。

8.1.2  类目录、文件目录的制作应依据原件分类、组织、编排及栅格文件组成的结果来进行，其文件格式均为纯文本。

8.1.3  文件目录应能正确反映文件的内容，否则应作修改和补充。

8.1.4  目录条目应正确、规范，原目录中的错字及不规范字经查证后应予以改正。

8.2  类目录

8.2.1  构成

 类目录是以一份电子文档中所含栅格文件的类名及各类中所含文件册的册序号、册题名以及所对应的文件目录文件名作为目录条目，应按封面类、正文类、审批类、附图类、附件类、附表类、其它类的顺序排列。

8.2.2  条目格式

文件类目录的格式由3个字符段组成。第一字符段为类名（当存在多个栅格文件册时，还包括册序号、册题名）；第二字符段为分界符“@”；第三字符段为文件目录文件名。

xxxxxxxxx   @   xxxxxxxxxxx                                                                                                                                                             
　

                                          
文件目录文件名
                                          分界符
                                                          于 类名（册序号、册题名）

    
　图2  类目录条目格式示意图
    文件目录文件名由11个半角字符组成，根据其标识作用分成6个字段：类别位、册序位、间格位、最终顺序位、间隔符及文件名后缀。各部分在文件目录名中的位置见下图：
件目录名中的位置见下图：

                                     

                                                            文件名后缀

                                                             间隔符

                                                             最终顺序位

                                                             间隔位

                                                             册序位

                                                             类别位

     图3  文件目录文件名的结构示意图
　

类别位：栅格文件册的类别，用本标准6.1.1中规定的相应英文字母表示。
册序位：栅格文件册序号。
间格位：本标准规定为“_”。
最终顺序位：栅格文件册的最终顺序号。
文件名后缀：本标准规定为“ml”。
8.2.3  编制方法
a. 一般规则
1） 电子文档的某一类中仅含一个栅格文件册时，只标类名，可省略册序号及册题名；当含有
多个栅格文件册时，除标注类名外，还应将各文件册的册序号、册题名标注于类名下。用阿拉伯数
字标注册序号，其后标注册题名。册序号左边空2个字节；册题名与册序号间空1个字节。示例见例4。
例 4：封面@f01_0008.ml
正文
  1 地质部分@z01_0122.ml
  2 矿产部分@Z02_0098.ml
  3 放射性部分@z03_0020.ml
审批@s01_0003.ml
附图@t01_0003.ml
 
 
    2） 册题名应用简洁、明了的文字来揭示栅格文件册的主题，其题名与图文地质资料题名相同
的部分可省略，示例见例5。

例5    永新幅G-50-7 1/20万区域地质测量报告书
正文 
1 地质部分（1－4章）@z01_0075.ml
2 矿产部分（5－7章）@z02_0042.ml
3）当多册栅格文件的册题名与图文地质资料题名完全一致时，应根据其每册的主题内容另立一个简洁明了的题名。
4) 对于电子文档中只有某一类文件(如图、表等)时，可以不标注其类名，但应标注简要题名，示例见例6。

例 6： 
 原件为：        湖南省地质图：1:100万
  类目录标注为：　湖南省地质图@t01_0001.ml
b. 目录条目编制方法
1) 封面类目录条目：只标注类名。
2) 正文类目录条目：仅含一个栅格文件册时，只标注类名；若含有多个栅格文件册时，还应著录各自题名中不同的部分，示例见例4。若章节连续，页码不连续，在题名字段后应将各册所含的“章”标注于括号内，示例见例5。
3)  审批类目录条目：只标注类名。
4) 附图类目录条目：仅含一个栅格文件册时，只标注类名；若含有多个栅格文件册时，还需标注册题名。示例见例7。
例 7：
附图
1 图@t01_0055.ml
2 物探成果图册@t02_0060.ml
5)  附件类及附表类目录条目：其编制方法参照正文类目录条目的编制方法。
6)  其他类目录：电子文档中原件的目录、勘误表及制作电子文档的责任者均放于此类，且只标注类名。
8.2.4  文件名
类目录的文件名规定为“sub_dir.ml”。
8.2.5  条目字段长度的规定
类目录每行字段长度规定为28个字节，目录条目超长时应折行，折行与前行文字部分左对齐，折行与被折行都需标注文件目录文件名。目录终了需做回车处理。

xxxxxxxxx   @   xxxx
                                                                                        栅格文件顺序号

                                     分界符                                 目录条目

图4  文件目录条目格式示意图
8.3.3  编制方法
a. 封面类
1) 只含有一个封面、题名页等时，以所含文件的题名及相对应的栅格文件顺序号作为目录条目，依序标注，示例见例8。
例 8：
封面@1
题名页@2
绪论@3
工区全景照片@5
2) 含有多个封面、题名页等时，应按正文顺序在各正文的简要题名下依次编制各自的封面目录。正文简要题名下的条目左边空2个字节。其示例见例9。
例 9：
地质部分@1
封面@1
题名页@2
前言@3
         矿产部分@4
封面@4
题名页@5
前言@6
 b. 正文类
1) 以正文的章、节、条、款标题和后置页文件题名及所对应的栅格文件顺序号作为目录条目。
2) 正文的章节目录揭示程度应遵循与原目录一致的原则，但一般不应超过四级。
3) 目录中“章”、“节”等字样予以省略，其级次用代码表示。
以上部分的示例见例10。

例 10：
     原目录为：
第一章  绪论……………………………1
            第一节  目的和任务……………………1
              …… 
            第三章  矿区地质特征…………………5
            第一节  地层……………………………5
            第一条  变质玄武岩……………………5
              …… 
            第三章 第二节 第二条 石英脉………12
应表示为：
            1    绪论@1
            1.1  目的和任务@1
              ………………
            3    矿区地质特征@5
            3.1   地层@5
            3.1.1 变质玄武岩@5
               ………………
            3.2.2 石英脉@12
 4) 正文目录条目先标注章节代码，其后标注文字部分，所有文字部分左边应对齐，并与最长的代码之间空一个字节。对第一章前未编章序号但又有节、条、款的部分，应用“0”表示其章序号，然后再编制相应的“节”、“条”、“款”等代码，示例见例11。对最后一章后面未编章序号但又有节、条、款的部分，章序号顺延。
例 11：
0     前言@1
0.1   白土坎滑坡概况及危害性@1
0.2   任务由来及目的任务@2
0.3   完成工作量及质量评述@3
1     自然地质环境条件@6
1.1   气象水文@6
1.2   地形地貌@7
5) 当各“章”下面的“节”有部分缺失时，如有“章”无“节”或有“章”无“节”又有条，编制目录时应在“节”的位置用“0”表示。示例见例12。
例 12：
原目录为：
    第二章   ……
……………………………
第二节   ……
（一）  形态特征………………………………………………12
（二）  滑体结构特征…………………………………………14
（三）  滑带（面）及滑床特征………………………………17
（四）  滑坡复活变形迹象与特征……………………………22
1   滑坡地面变形特征……………………………………22
2   滑坡深部位移特征……………………………………25
第三章    滑坡复活变形成因机制分析…………………………31
第一条    滑坡复活变形成因机制的地质分析…………………31
第二条    滑坡复活变形的“概念模型” …………………… 37
第三条    滑坡复活变形机制的数值模拟………………………39
应表示为：
2       ……
            ……………………………
            2.2      ……
               2.2.1    形态特征@12
2.2.2    滑体结构特征@14
2.2.3    滑带（面）及滑床特征@17
2.2.4    滑坡复活变形迹象与特征@22
2.2.4.1  滑坡地面变形特征@22
2.2.4.2  滑坡深部位移特征@25
3        滑坡复活变形成因机制分析@31
3.0.1    滑坡复活变形成因机制的地质分析@31
3.0.2    滑坡复活变形的“概念模型”@37
3.0.3    滑坡复活变形机制的数值模拟@39
5）顺序号相连而章节不是连续编的，在目制作中应使用原章节号。示例见例13。

例 13：        上册区域地质部分@1
1     绪言@1
1.0.1 目的任务及工作概况@2
……………………………
2.2   石炭系@15
……………………………
 下册区域矿产部分@42
1     矿产概述@42
1.1   煤@42
1.2   汞@44
1.3   锑@46
………………………
3.2  冰洲石远景区及工作建议@58
c. 审批类
以各审批文件的序号、审批文号、审批形式及对应的栅格文件顺序号作为目录条目，无审批文号的以审批机构简称、审批文件形式及对应的栅格文件顺序号作为目录条目。示例见例14。
例 14：
1 冀储决字（1993）66号决议书@1
2 河北地矿局审查意见书@4
3 一地勘地字（1993）第199号关于发送@13
 《审查意见》的通知@13
d. 附图类
以每张图的图名、比例尺及对应的栅格文件顺序号作为目录条目。图件名应能清楚揭示图件的内容；主要图件如区域地质图、矿区地质图、水文地质图、综合柱状图、钻孔柱状图等的题名应正确、规范，否则需修改或补充完善；比例尺符号用“/”表示；小于等于一比一百的比例尺用中文“百”、“千”、“万”表示数字单位，示例见例15。当图号与顺序号不一致时，应在题名前方加图号；发生折行时，折行与前行文字左对齐，示例见例16。对于目录条目中不影响主题内容的繁琐词组，可省略，示例见例17。
例15：     原件目录为：
   区调图   1:50000 ………………………1、2
应修改为： 
苏吉幅区域地质图    1/5万@1
            双井子幅区域地质图  1/5万@2
例16：
1 大华山幅电测AB/2=40米等视电阻@1
 率平面图                  1/5万@1
1 平谷县幅电测AB/2=40米等视电阻@2
  率平面图                  1/5万@2
………………………………………
1 安次幅电测AB/2=40米等视电阻@14
  率平面图                  1/5万@14
2 大华山幅电测AB/2=100米等视电阻@15
  率平面图                  1/5万@15
 ………………………………………
2 琉璃河幅电测AB/2=100米等视电阻@26
  率平面图                  1/5万@26
2 庞各庄幅电测AB/2=100米等视电阻@27
  率平面图                  1/5万@27
2 安次幅电测AB/2=100米等视电阻@28
  率平面图                  1/5万@28
3 大华山幅电测AB/2=225米等视电阻@29
  率平面图                  1/5万@29
3 平谷县幅电测AB/2=225米等视电阻@30
  率平面图
…………………………………………
例17：      原目录为： 新疆哈密市企鹅山金矿床平面地质图………………………1
            新疆哈密市企鹅山金矿床平面地质图及工程分布图………2
目录中"新疆"二字可省略。
e. 附件类
    以附件内的详细目录（无详细目录时用附件题名）及相对应的栅格文件顺序号作为目录条目。若文件为“章”、“节”形式则应参照正文目录编制方法。
f. 附表类
    以附表中各表的题名及对应的栅格文件顺序号作为目录条目。若一册表中表名过多，可将表归类后标注概括性题名。
g. 其它类
以归入其它类中文件的详细目录（无详细目录时用该文件的题名）及对应的栅格文件顺序号作为目录条目，具体编制方法根据文件的形式参照上述各类目录的有关条款。当电子文档中含有目录、勘误表时，应标注“原件的目录”、“原件的勘误表”字样，如果原件含多类目录时，应按所属类分别将其列出。此外，制作电子文档的责任者也放于此，示例见例18。
例 18：  原件正文的目录(上册)@1
原件正文的目录(下册)@4
原件附图的目录@7
原件附表的目录@12
原件正文的勘误表@15
原件审批的勘误表@16
 图文地质资料扫描数字化责任者@17
 
8.3.4  文件名
文件目录文件名的有关规定参见本标准8.2.2中的相应内容。
8.3.5  条目字段长度的规定
文件目录每行限制字段长度为37个字节，目录条目超长时应折行，折行与前行文字部分左对齐，折行与被折行都需标注栅格文件顺序号。每个文件目录终了需做回车处理。
8.4  盘目录
8.4.1  构成
盘目录以一个物理存储介质中所存储的电子文档号及电子文档题名作为目录条目。
8.4.2  格式
盘目录由三个字符段组成，第一字符段为电子文档号，长度限定12个字节以内；第二字符段为分界符，用“@”表示；第三字符段为电子文档题名，长度不作限制。
xxxxxxxxxxxx     @    xxxxxxxxxx
                                                       

电子文档题 

分界符
                                                                电子文档
图5  盘目录条目格式示意图
8.4.3  文件名
盘目录文件名规定为“main_dir.ml”。
8.4.4  编制规定
a. 盘目录文件的第一行需空行，预留为存储介质编号写入区；目录终了需做回车处理。
b. 在盘目录中，电子文档题名原则上照录，对确实不能反映电子文档主题的应依照《地质资料档案著录细则》中的有关规定进行修改或重新编写。题名中图幅号、项目号等中的数字、文字、字母、符号间的连线除文字之间用双短线“--”表示外，其余的均用单短线“-”表示。
8.5  角标的录入规定
目录条目中出现角标时，要在上角标前加入“^”符号，下角标前加入“|”符号，并用“〔〕”符号(中括号)将角标的内容分别括起来，示例见例19。
例19：    如原件为：Ⅲ2E+B
                应表示为：Ⅲ|〔E+B〕^〔2〕

9  保存数据
9.1  保存数据前的质量检查
9.1.1  每一个电子文档的内容应完整，数量应准确。
9.1.2  电子文档的质量及文件格式应符合本标准的要求。
9.1.3  电子文档能够在“图文地质资料数据库”系统中进行浏览和使用。
9.1.4  经检查无计算机病毒。
9.2  数据的保存
9.2.1  电子文档的保存要利于管理和方便利用。
9.2.2  同一电子文档应尽量保存在同一个物理存储介质中；当文件过大而需保存在数个物理存储介质中时，应在第一个存储介质中保存一份完整的三级目录。
9.2.3  电子文档应保存一式3套。
9.2.4  电子文档保存到载体上后，应在数字国土工程“图文地质资料数据库”系统中进行浏览检查，保证能够读出电子文件。
9.2.5  保存数据的载体，应具备利于长期保存、保管条件相对简便、数据不易更改的条件，目前暂以“CD-R”(光盘)为宜。
9.2.6  保存数据的存储介质，需在外部标注外标签，注明编号、形成时间；必要时可标注所存电子文档的目录，标签格式见附录C（提示的附录）。
10  其它
10.1  责任表
10.1.1  用于记录制作图文地质资料扫描数字化的责任人、单位、时间等内容，其格式如下。

图文地质资料扫描数字化责任者
                                               
题名
负责人
扫描
整饰
检查验收
制作单位  
负责单位  
制作日期  
10.1.2  责任表中题名的字号和字体为3号黑体字，其余的统一为4号黑体字。
10.1.3  由责任人亲手签名后制作成栅格文件，置于其它类中。
10.1.4  责任表的示例见附录D（提示的附录）。
10.2  扫描仪的月检
为保证栅格文件的精度，每个月应对有精度要求的扫描仪进行一次精度测试，并将测试数据及精度值正确填入附录E（提示的附录）所示的表中。
附 录 A
（提示的附录）
将大图二值文件转换为彩色文件的原则及方法
 

一、原则：
1．  将彩图扫描成黑白文件后所进行的整饰工作量不应太大，否则宜扫成彩色文件；
2．  图件的颜色应简单(不含黑白色，三种颜色以内)、色差要较大；如工程图、
3．  所要填充颜色的图块应为封闭(如果不封闭，使用手工将其封闭且工作量应尽量小)；
4．  同一份报告的彩图应尽量使用同一种方法处理(或全部使用此法或全部扫成彩色文件)；无论是只使用此法或两种方法交叉使用，均应保证填充后的颜色与原图尽量保持一致、对同一颜色的块及其图例(包括不在同一图件上)的填充必须使用相同的颜色。
 

二、方法
   将一个黑白二值文件转换成24位JPEG彩色文件的具体方法如下 ：
1．  扫描及整饰：将图件扫描成二值文件(tiff压缩格式)，然后按规范要求进行整饰；
2．  进行红线批注：在编辑软件“Preditor”中，使用“创建红线批注文件”命令(参见ANATech Eagle Evolution扫描仪技术手册汇编P112)，即执行“File→New→Creating Redline Files→选取要进行填充颜色的二值文件后点击OK”；
3．  填充颜色：在调色板上选取填充色，然后执行“Draw→Flood(填充命令，参见扫描仪技术手册P163)”，对要进行填充的区块进行颜色填充，如果要填充的颜色不止一色，则需要重新取填充色后，分别填充；
4．  保存文件：点击工具条上的“Save”进行文件保存；
5．  格式转换：执行“File→Convert(文件转换命令，参见扫描仪技术手册P131)”，在“Input File(输入文件)”处选取上一步保存的文件，在“Output File(输出文件)”处填入将要转换成彩色文件的文件名及其绝对路径 (如“C：/ZL/t01_0005”)，在“Output Format(输出格式)”中选取“JPEG-24 Bit Compressed(JFIF)”,点击“OK”后再选取“quality Factor(质量因子)等于75”, 再点击“OK”即完成全部工作，此时产生的文件即为一个24位的JPEG彩色文件；
6．浏览及检查：在浏览软件中将上面产生的彩色文件打开并进行质量检查；
7．将上述各步中产生的多余文件删除。
附 录 B

（标准的附录）
空白页示例
说明：
1．  示例1用于原件本身就是空白页的扫描； 示例2用于因拼接而形成空白页的扫描；

2． 其上的“空白页”三个字，字体采用宋体，字号采用初号字，居中纵向排列； “此页拼接到第XXX页”，字体采用宋体，字号采用一号字，居中横向排列；空白页外的黑框仅用作示例，不应作为空白页的内容进行扫描。
示例1：


           空

白
示例2：
空
 
白
 
页
 

此页拼接到第XXX页
附 录 C
（提示的附录）
保管单位标签示例
保管单位外标签
 

NGA00024                      2000年4月
DZ000451 三门幅G-49-76-D同列幅G-49-88-B 1/5万区域地质调查报告
DZ000452 陶赖昭幅L-51-30 1/20万区域水文地质普查报告
DZ000453 香海庙幅L-51-27 1/20万区域水文地质普查报告
附 录 D

（提示的附录）
责任表示例
图文地质资料扫描数字化责任者


  


　

题    名     抚州幅H-50-33　1/20万区域水文普查报告
负 责 人      高谊明
扫    描　　　李淑仁
整    饰　　　董建秀
检查验收　　　黄　冰
制作单位　　全国地质资料馆
负责单位　　国土资源部信息中心
制作日期　　2000年5月18日
附录 E

（提示的附录）
扫描仪月检表
扫描仪月检测试表

     1.横向精度：不进行校正，选两线进行测试。
	 
	实际长度
	测量长度
	误差率

	上部线
	 
	 
	 

	下部线
	 
	 
	 


 
     2.纵向精度：分两线（左部、右部）进行测试，校正后记录其校正值。

	 
	实际长度
	测量长度
(校正前)
	误差率
(校正前)
	测量长度
(校正后)
	误差率
(校正后)

	左线
	 
	 
	 
	 
	 

	右线
	 
	 
	 
	 
	 


        本月纵向校正值：________测试人员:__________测试日期：  年  月  日

附录 F

（提示的附录）
扫描数字化工作流程示意图
图文地质资料扫描数字化工作流程示意图
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